Kato & Rudes Atlas Workshop Il

Guide to the Basics of Atlas.ti |

Atlas.ti Workshop Il

October 17", 2008

Yuki Kato
Tulane University
vkato @tulane.edu

Danielle S. Rudes
George Mason University
drudes@gmu.edu



mailto:ykato@tulane.edu
mailto:drudes@gmu.edu

Kato & Rudes Atlas Workshop Il

The following document is a hands-on, “how to” guide to Atlas developed by your workshop facilitators. In this
second phase of the workshop will explore some of the most commonly used Atlas tasks. We will not cover
everything in this handout. However, you can use the guide as post-workshop review as you begin utilizing

Atlas for your own research projects.
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Starting a project
Foolproof method of starting a project

1.
2.
3.

4.

Create a new folder for a project (anywhere on your computer)

Move the original documents (they will be PDs) into the same folder

Create an HU file in the same folder

File > New Hermeneutics > Save

Assign the PDs

Primary Document Manager - Documents - Assign - highlight the documents
and hit “OK”

Copy bundle

Create a bundle

Tools - Copy bundle - Create bundle > Save as .acbh

Open a bundle

Tools - Copy bundle - Install bundle > Open (Use “Migrate” to move to new HU
folder)

Playing around with primary elements

1.

Opening PD:
sertation [ '.

Opening HU:
File=> Open - select the HU

E-OB A4 & GMe-2¢-Yy

1 R =3 [[] 10 1 Paonec ] C Coden ] Aclt sacen: & == [[] -

P primary Doc Manager [HU: Dissertation Data]

“~" means
“with memo”

Comment

Backing up HU

Setting the backup preference

Extras > General Preferences > Storage - Check “Always backup copy when
saving a HU”

Every time you “back up” Atlas saves an HU and updates the backup. BUT it is not
done automatically.

-> This is different from recovery backup, which is automatic.

There’s no UNDO button or function in Atlas, so you could make multiple HU copies
to prevent a fatal error that could make you lose hours of work.



How the coding works
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- Primary documents are broken into smaller units (quotations).

- Quotations can exist without codes or can be linked to multiple codes.

- Memos can be attached to any parts.

Openlng Code Manager
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walked outside to be picked up by a white SUV that drove up to the curve. The Middle EasternIndian »
girl also left shortly after that T saw her walk through the parking lot and zet o a Civic

The gitls were generally oblivious to other customers in the store. Thev did not rurn their head —
to see who came m. or when others i the store made noises. At one point a group of twoe mothers and
two small bovs came into the coffee shep. The older bov, about 6 vears old had a TaeKwonDo outfit,
and after getting a cookde at the counter, he walked toward the table where the black girl and the
Indian girl were smdying. The boy put one of his knees on a chair where Middle EasternTndian girl
was siming earlier. He was staring at the two high school teens smdying for excessively long time (at
least 3 mimites). The girls did not even turn their heads to acknowledge him the entire time he was
staring at them, but he did not verbally address them either. Evenmally his mother came by and lightly
tapped him on the shoulder to tell him to start walking toward the deer. The bev did not resist much and
walked out of the coffee shop with them.

At around 3:20, I noticed a black boy sitting outside alone. He had a white paper bag in front of
bim o the table, and took a sandwich out of it and began eating. The bag appeared to be from a
French bakery Champagne at the corner. He was wearing a sporty-outfit with a pair of red loose
running pants with white t-shirt. He sat there alone. eating for a while, and then was joined by a Latino
bev at around 5:30. This bov was wearing white oversized t-shirt over a pair of loose jeans. He sat next,
te black boy and they sat talked. The black bov came mside at 3:40 te order a frozen drmnk (it was pmk
so it was probably a smoothie). As he walked in, ordered. drink and waited for the drink to be
prepared, there was no interaction (not even an eve contact) with the girls working en the homework
The Latino boy left alone at 5:50pm, walking toward Del Taco. It must have been getting cold, becagie
the black boy put on a black windbreaker at around 3:35. He held a cell phone in his hand that he pylon
the table. When I looked up at one point he was looking throush a pile of flashcards. He got up an
began walking toward the parking lot at around 6:07. He had a backpack on his back

At around 6:00pm, a black man in his late 40°s walked from Barnes and Nobles direcu
toward Tu]]x s \m.h a little black girl LS IU vears uld) As tha\ were w a]lmz b 'Lhe blacl\ boy (hyffw: as

name}!” The litle gu’l q\_nc 3
said “vour sister’s so cute!”
About 10 mimites later, the black girl leoked up and saw that the man gestured her,

did ot wait for her and began walking toward the parking lot (He was not with the fitdle
time). The Indian girl asked her “Are vou leaving right now 1z
him right now ~ After a few seconds, I saw the black girl run outside (with her smff < i bl
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Comment on quotation

When there is a comment, you can double-click to edit it.

e Code Manager

7 Codes Street {1-0} All Name - Title

&) i

Roll-up
option

View
- Single Column

“Marginal Space (52:1)~"
This code has links to 52
quotations, and is linked to
1 code.

It also has a comment

(~).

Comment on codes

l_ﬁ; When there is a

comment, you can
double-click to edit it.

Double-click on any code and it will open the list of all quotations linked to the

code.
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to see who came & of when edms = the nere mad,
two small beys came &mo the coffee shop. The older by
and after gemmng a cockie at the couter, he walked toy

was siming earber. He wat staring at the o high schd
leas § mimmes) The girls did not even nen their heads] |
starmg at them, but he did not verbally address them
tapped him on the shoulder to tell b to start walkmg
walked ot of the coffee shep with them.

e on the vable, and tock a sandwich o of it and began earmg. The bag appexred 1o be from 3
French bakery Champagne ar the corner. He was wearing a sperty-ourfst with 3 pair of red loase
nunesng pams wih white t-shine. He sat there alene, eamng for 3 while, and then was joined by a Lanno
by a1 around ‘Thas boy was wearng white eversied 1-shirt over a par of loose jeans. He sar next
to Black bov and they sat talked. The Back bey came méide at 540 to order a frozen drnk (it was pimk
g0 it wak probably 3 emocthie). At he walked m, ordered drnk, and waited for the drink 1o be
prepared, there was no intéraction (ot even an eve contact) with the girls workeng on the homewark
The Latiso bov left alone at 5 50pm, wallang oward Del Tace, It munst have been getting cold, because
the Back bey pust on a black windbreaker a1t aroumd 5 55 He held 2 cell phone m bes hand that be put en
£ the table. When 1 looked up at one pot he was looking through a ple of Bashcards. He got up and

towaed Tully's with 3 Brde black g2l (
alene by then), they appeared 1w have exchanged a werd or rwo with him (b t's possible that the Enle
gl decided to walk i Sigzag theough pane tables). Then the bnle girl walked im0 the store and said b
to the black gl workang on the hemework. The black teen turned arcund and said “Hi ___(the gal's
name)!"” The brle gl quickly rumed and went back to walk with the man. When she left the Indian girl

wavmg hand away from the coffes shop. The gol snd “Oh, are we leaving sght now™" Bt the man
ded mot want for her and began walkmy toward the parkeng lot (He was not with the Bnle gl at thee
tane). The Indian gul asked ber “Ase vou leaving naht mow

Indian girl were studving. The bov put cne of bis knees| |

At wound 520, I notrced a black boy sttng

When you click on any code, Atlas will take you to the quotatlon

Il X &=

cgan walkdng toward the parking bot at around 6:07. He had 2 backpack on his back
A around 6:00pm, a black man i his lare 40°s walked from Barnes and Nobles direcrion
10 vears old). As they were walldng by the Hack bov (he was

aid “vour tister's go cute!”
Abeut 10 minsstes Later, the black 2! looked up and saw that the man gesnured her 10 go by

* And the black gl responded “T'm calimg ¥ ||

Quotation
Comment
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- Or, you can right-click on the code in margin area and select “List Quotation” to
get the list.

7 Commercial Places Coding 2007 - ATLAS.ti = inager [ N EE
S———
File Edit Documents Quotations Codes Memos MNetworks Views Tools Extras Windows Help
(E-EOdH EH B FEe2 ey

i pDocs | [E][P 1 commerciz )] | Quotes 1:20 s he we ) || Codes | E][Getaride (70,9 : Memos ~|
alone. By thon [ figared that the three were working on French homework. She stayed until 6:00pm and & ] —
walked outside to be picked up by 2 white SUV that drove up to the curve. The Middle-Eastern/ndian :IQ e
irl also left shortly after that. T saw her walk through the parking lot and get into a Civic.
023 The girls were generally oblivious to other customers in the store. They did not turn their head
to see who came in, or when others in the store made noises. At one point a sronp of two mothers and .
two small boys came into the coffee shop. The older boy, about 6 vears old. had a TaeKwonDao outfic — ||| argin area
and after getting a cookie at the counter. he walked toward the table where the black girl and the
Indian girl were studying. The boy put one of his knees on a chair where Middle-Eastern Indian girl
was sitting earlier. He was staring at the two high school teens studving for excessively long time (at
least 5 minutes). The girls did not even turn their heads to acknow IEdUE him the entire time he was
staring at them, but he did not v erbally address them either. Ev: Entua]l‘ his mother came by and lightly

tapped him on the shoulder to tell him to start walking toward the door. The boy did not resist much and
walked out of the coffee shop with them. i
024 At around 520, T noticed a black boy sitting ourside alone. He had a white paper bag in front of ~ i| €5 #8lack % soo

B SERSD U

him on the table, and took a sandswich out of it and began eating. The bag appeared to be from a Q =Lating

French bakery Champagne at the corner. He was wearing a sporty-outfit with a pair of red loose #Male

rinning pants swith white t-shirt. He sat there alone, eating for a while, and then was joined by a Latino | g pubaptive Space:

boy at around 5:30. This boy was wearing white oversized t-shirt over a pair of loose jeans. He sat next =
g: ATeen/Teen interaction

i o

1o black boy and they sat talked. The black boy came inside at 5:40 to order a frozen drink (it was pink
Rt Ol e Rt i M A s he walked in, ordered. drink. and waited for the drink to be
epared. there was no interaction (not even an eye contact) with the girls working on the homework. Frime Spacer
The Latino boy left alone at 3:30pm. walking toward Del Tace. It must have been getting cold because g -------- 7

the black boy put on a black windbreaker at around 5:55. He held a cell phone in his hand that he put on ~|  Code: Purchase
the table. When I looked up at one point he was looking through a pile of flashcards. He got up and ]j £ walk

began walking toward the parking lot at around 6:07. He had a backpack on his back.

025 At around 6:00pm, a black man in his late 40°s walked from Barnes and Nobles direction
toward Tully’s with a lirde black girl (8-10 vears old). As they were walking by the black bov (he was
alone by then), they appeared 1o have exchanged a word or two with him (bt it°s possible that the linle Edit Comment
girl decided to walk in zigzag through parie tables). Then the limle girl walked into the store and said hi
1o the black girl working on the homewaork. The black teen murned around and said “Hi __ (the gitl's
name)!” The lirle girl quickly urned and went back to walk with the man. When she left the Indian girl Open Netwark

said “vour sister’s so cute!”
026 About 10 mimues later, the black girl looked up and saw that the man gestured her to go by —‘ﬁ #Black Unlink

@4 g

B

Display Info
Rename

Delete

waving hand away from the coffee shop. The girl said “Oh, are we leaving right now?” But the man $3 =Female
did not wait for her and began walking toward the parking lot (He was not with the lirtle girl at this £& Getarice
time). The Indian girl asked her “Are vou leaving right now?” And the black girl responded “T'm calling ¥
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Creating Codes: Coding Methods

1. Open Coding
- Create code based on the document you're coding Open coding:

- You can enter more than one codes, separately by “|” (a pipe) Create codes as
you go

2. Free Coding
- Create codes in advance

3. Invivo coding
- Highlight words that you want to use as codes, and drag it into code Free coding

manager. (Turn off the rollup option for this.) Coddes are created
in advance

4. Creating codes in memo
- Create a new memo -> List codes, one code per line (You can import from Word)

- Miscellaneous - Create codes from selected memo - Delete the J

memo once codes are created Invivo coding:
Making codes out

5. Margin dragging of the PD text

- Drag anicon for a code linked to a quotation to another quotation.
Il move to the new quotation

6. Copy codes Auto coding
- Hold down Ctrl key and move code icon from one quotation to Search and code

another quotation specific word or
fragment of a word
7. Auto coding
- Look for a word (or fragment of a word) and code it automatically
- Code manager > Codes = Coding - Autocoding - Create a new code (It's a
good idea to note that it's an auto-code)




Coding: How to code

Tips on coding
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- Select where to look for the auto-codes (e.g., Current PD, All current PDs, PD
family...)

- Select the size of quotation
- Single hard return = any paragraph mark will end the quotation.

- Multiple hard returns = one or more lines will mark the end of the quotation.

- You can enter more than one “search expression,” separately by “|” (a pipe). If
you need the words to be searched under different forms, place * after each word
that needs to be.

e.g., *father - search will include “grandfather”
e.g., *father* - search will include “grandfather-in-law”

- The best way to use auto code:

Auto code - Manual code (to fix and clean up) - Delete the auto codes and
spurious codes

Highlight the text and then drag the codes from the code manager and drop it
anywhere in text area.
To remove codes, Right click 2 Unlink

Note: Do NOT delete the codes!
To replace codes you can drag another code over preexisting codes
Two ways of renaming codes

a. Click on it once - wait a second - click again - rename it

b. Right click 2 rename it

Code the current selection with the selected code <

Highlight the document efficiently
1 click = a word
2 clicks = whole sentence
3 clicks = whole paragraph
4 clicks = whole document
5 clicks = unhighlight everything
e When you click the areas that are not highlighted it will unhighlight the
quotation.
¢ When everything is highlighted, shift+click to unhighlight.

Teamwork: Placing a coder’s initials on codes will help sort through the coding after
merging multiple HUs
Naming files and documents
Identifying the codes (variables) in file will help make it easier to sort.
When merging files documents must be in the same order. So, using numbers in
front of the original documents will help ensure that everyone has the documents in
the same order.
e.g., P1: 001_M_RFM_120405.doc

P2: 002_F_DFM_113005.doc

P3: 003_F_RFM_112405.doc
Wrap tool bar
This will help prevent the shortcut buttons from disappearing when you narrow the
code manager window.
Code Manager - View - Wrap Tool Bar
Making “Great Quote” code: use the query “AND” to find a great quote for a
particular code
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Quotation
Increase or decrease the size of quotation

Press down shift and extend or reduce the size of quotation to where you want to be,
and then check to approve the changes.

Code managing and quotation managing

It's always a good idea to work at the most detailed level (You can always merge
them later).
Using a symbol or a number to sort the codes is one way to organize them.
Merging codes
a. Merge codes in code manager
Click on a code - Miscellaneous > Merge codes - Select the code to merge
the original code with
b. Visually merge codes
Highlight codes inside code manager (Hold down Ctrl to highlight multiple codes)
- Network button
-> Highlight the codes you want to merge (draw a square with the curser to
include ones you want to highlight)
- Nodes
- Merge codes
-> Click on one that you want to keep the new code as
Note: Keep in mind that you can also do supercode to keep the original codes (so
merge only when it's clear that one of the codes no longer makes sense as a stand-
alone code)
Merging quotations
- Highlight a quotation while holding down Ctrl > Drop the quotation onto the
quotation that you want to merge the first quotation with while still holding down
Ctrl (don’t let go of Ctrl until you drop the quotation)
Note: If you don’t hold down Ctrl, then the two quotations will be hyperlinked.
Codings Analyzer
Tools - Codings Analyzer
It allows you to check for the redundancy in coding (It's useful for team coding)
Concurrence Explorer
Tools - Concurrence Explorer > Codes - “<o0>” signifies concurring codes

Writing Memos

Click on memo manager-> memos->create free memo (or use the far right symbol of
a memo with a yellow star in the top left corner)> type your memo in the white
space—> change the title of your memo if you like=> click the check mark to save and
then close out of the memo.

Comments

Using code comments

You can leave notes on the meaning and definition of the codes.

In teamwork, leaving a coder’s initials and the date of the comment will help
effectively maintain the integrity of the work.

Using quotation comments

Leave notes that explain why you coded it in certain ways or provide your
interpretation of quotation.
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Creating Families

- Open family manager
a. Code Manager > Codes - Edit Families - Family Manager
b. Code Manager - “Open Family Manager” icon
- Create new family
“Create new family” icon > Name a family - Double click codes on the right to
move them into the family
-> Once you do this, when you double-click on the supercode, then the code
manager will only show codes in the supercode
Note: You can create ad-hoc families and later delete irrelevant families

Open Family
ifommercial Places Coding 2007 - ATLAS.4 ‘ B Code Manager [HU: Commercial ... EH? ﬂgll Man ag er
. S5 teiohation . L : P Codes Edit Mscelaneous Output View
KE-Od th B2 EEe-F ey BERO P K XS =-
i Pocs | [F][P 1: commerdial place fieldnotes. doc~ W] ¢ Quotes . Al I .
5 boy. The boy caught to but one hihe <1 told the bo g] THsDupicate (100 Create New Family
i he can't do that. and the boy wa oding 2007] $3 Adaptive Space (811}~
o4 by the counter appeared to be g gBamraam {10}
older-boy booth. The black bay] . . = s AT
= vounger boy shake his head ges %0 I8 F | X & H - £3 bubble {103
5= boy (white) said “bye ----(the of | Name Size Author Created Modfied gg“g‘;r‘g;w;{fﬁ
= |[as8 As T was getting ready tf | € Actvites Typdlog... 12 Super 1241105, QD:\ T:m {n;w)
=48 from the stores. Thev looked to & interacton Typol... Super 12/11/05 e e i
some food. Just a few seconds | $2eeopie Typologes 15 Super 12/11/06. £2 Gift or Entertainment store {3-0}
T store areas. They reached the d gP\ace Typologies 3‘1 Super = 12[11,'13& | Marginal Space {55-2}~ I
= A N—— Transportation T... 3 Super 12/11/06... 12/11/05... £2 Other fast fond (100}
o |2 When 1 left T heard a loy 82 Paric (0.0}
saw more than half a dozen tee anma e
99 parking lot merges. The area wd — Q:E:tmj:";f‘ﬁ}{gﬂ} Ge—— S h ad ed means
| ettt 1 T T S d filtered
=h not rgaﬂy' lﬂﬂldngl at the tEensl: by 5 ‘E % $£3 spectumstrest (30} coaqes are Tiltere
LR standing and talking, and I think €% Sirest {10}
360 1 drove to the other side £ supermarket {1-0}
% Tully's Coffee. $2 Tea house (3-0
3
263 | October 12, 2006 (Th) . i gy
Del Taco Barranca =
265 3-30-4:30pm
366
367 Tfound a group of teens| . :
them sit down. and then walked Flltered by (C“Ck
and their mothers. Some childre: Bl o family selected
working on homework at the table or playing in the sandbox and a frog statue in the middle of the 4 | ¥ here tO ShOW a” the
courtyard. I walked into Tully’s which was full. All the customers inside were adult. all women in ‘ Space with least defined uses/usdls. Stake for the Oth er Cod es )
their 30°s to 507s, except for a pair of male adult and a boy about 10 years old. The boy was property owner is lowest.
< - o - B 3 |2L codes Marginal Space {55-1 F:Place T Name - Title
Recovery backup: 10:56:23 AM Size: 100%  $4 | ANST | CPiD

s Start | Tl AtiasWorkshopMote... 7 Commercial Places Co... J0% &)F L, 5 0aEM

Total number of codes
Currently selected

a. Filtering codes by family
- Code manager > Codes > Filter > Families > Select the family of codes you
want to selectively show in the code manager
- To undo, Code manager > Codes - Filter > All
Note: In order to remind yourself that you have filtered the codes, change the Tool
Tips shading of Windows.
- Setting > Control Panel - Display - Appearance - Advanced > Tool Tips 2>
Select the color you like for the shading (in below example it’s light blue)
b. Filtering documents
- Code Manager > Codes - Filter > Selected PD
Note: You can filter documents where certain codes are used
Note: A case in which it's useful to turn an entire document into a quotation: If you
need to know that the characteristics matters permanently, and place it in supercode,
then you must code the entire document as one big quotation (e.g., demographic
information of the interviewee)
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Hyperlinks

a. Hyperlinking part of a document to another
- Highlight a part of the document - Click on “Hyperlink start anchor” - Select
another part of the document - Click on “Hyperlink target anchor” > Select the
type of hyperlink
- After this, when you double click on the hyperlink icon, it'll show the linked text.
Note: Once you’'ve hyperlinked the quotations, you could unlink codes from all but
one quotation (i.e., all the linked quotations will be coded similarly)

| Commerial Places Coding - ATLAS i ==X

E-OH -E# & & > ey

P-Docs | E)|P 1: commercial place fieldnotes.doc~ (3] /¢ Quotes |E]]| >1:335 T satin my car and left my fi. (265: %] : Codes | [F]| #Adult customer: & Memos ]| v

and followed them inside the restaurant. As I entered the restaurant, I ended up passing them, as they 4
were walking very slowly. I held the door for a boy after T opened the door, and he said “thank you™".
Once inside the store, I slowed down, so the bovs passed me and headed to the counter. They were up
at the counter for a few seconds, while I was locking around by the door. observing the inside of the
restaurant

There was a group of three teens, two boys and a girl, at the booth closest te the counter, whe
had some food that they'd already finished. There were three more groups, and only one of them

P prime Space~

looked like teenagers. It was a group of four bovs. Outside, there were two tables on the patio, with || $Hada
=5E about four at each table, were sitting and talking. ]
. ien I finally walked up to the counter, the boys turned around and said “thev’re closed™ I
Hyp erl n k “they’re closed™ and one boy responded “Yeal, and the store’s evil” as he pointed at the §BPrime Space-

»r_Tt showed the total amount of sales from the last customer, which came out to 56 66.

St art & E n d aind the counter was around to tend me, so I followed the bovs outside. I saw them walk
ertson’s, instead of getting in their car to go through the drive-through (So perhaps they | Rverarslsosce

Anchors ery for tacos). T watched them from my car as the four boys ried to cater Albertsons”
I the two doors that's closed after certain time i the evening. Thev stoed by the closed

entrance for a few seconds. eventually walked toward the door that's acmally open.

5 |l sat in my car and left my fieldnote mto my voice mail as I pretended to speak on the cell i B Bt
Jphone. One of the groups at the patio grew to 7 people. After midnight, T began to see people leaving s : I :
he restaurant one by one. Tn about § mimutes, all but the group in the patio and one group of adult [ETPTIETT P mwARWE T — TS » Hyp erlink

Indian graduate students?) had lefi the restaurants. I saw them get info cars and drive off immediate]

266 T saw the four boys walking back from Albertsons”. 1 didn't see them carrving anyehing in th I dreve t Del Taco at 10:30pm, but dd ot zee anyane, o came When you
< B : . : Py Fos s e | back out again at 11:50pm, and this time I found several groups of
hands, so L.he} either did net buy anything or finished consuming it belfure ‘coming szL 0 Lh; car. The et el s Sl e e d bl | k
separated info two cars, and then drove off. T wanted to see which direction they left, but since they |from where I could see the restaurant and the two of the entrances ouple CliCK on

drove so quickly out of the parking lot I could not see. I drove by In N Out afterwards, but I did not af to the shopping center, as well as parts of Starbucks Coffee

many peogle as last time_ There was one group of teens standing in the parking lot when I got there, | En72nces. 1 watched four teenage boys walking around the parking it you get the
) ; - gro ng g e Lot ot in front of my car. T saw them approaching Del Taco sfter & few ’
A but they, too, got into their cars and drove off while T was rurning around the corner of the parking 10t| minutes, so T got out of the car and followed them inside the .
26 I drove to Del Tace on Barranca to see if anybody was there, but the parking lot was dark agrestaurant. As 1 entered the restaurant, I ended up passing them, as || n ked teXt
quiet. There was no car parked in the corner where I sometimes see cars being parked and teens fusq ey were wialking very siowly, T held the door for 2 bay affer I ———
7 £ i 2 = “ENE UM pened the door, and he said "thank you”. Once inside the store, T
stanclmgr around. I al:q noticed Fhat this corner areais under construction, so it was fenced off partialll goyed down, so the boys passed me and headed to the counter, They
though it was still possible to drive around it were up at the counter for a few seconds, while T was looking around
by the coor, ohserving the inside of the restaurant. P
<
On the wav home, I drove by both Del Taco and In N Out. Del Taco had about half a dozen young £% Del Taco
people (some may have been college stdents). I saw groups of threes and fours eating mside and
outside. T didn’t see anv group of teens standing in the parking lot. At In N Out, there were some v mtEs oy
L — Expand/Contract

e - -
4 start | D Atlas Workshop Note... | * New Hermeneutic Uni... 7" CommercaliPlaces Co.... Rr,f L0 = 12-95pM

Images

Note: Hyperlinks are especially useful for videos and images.
Note: Hyperlinks are not an alternative to coding.

- TOOLS-->Query Tool (looks like binoculars)
- Double click on the codes you’d like to include in your query and select an
operator by clicking on the operator of your choice from the list of symbols on the

far left margin of the screen. .
- Use the recalculate, undo, etc. buttons as needed Query: Means to

i . P, . explore data
Make your query into a SUPERCODE if it is particularly useful officiently

Retrieving a quotation with a query

- Double-click the code - It will give you a list of quotation linked to the code
- Purposes of Query Tools
- Creating formula for exploring the data
- Housekeeping
i.e., check to see if | had coded the quotation properly
e.g., Dichotomous codes both linked to a quotation? You can check to see if
such cases exit (If you coded properly, then you shouldn’t find any such
cases).
- Scope of query
- You can limit where the query applies



Query tool

A E -E M

G- e-y

E][P : commercal place fieldnotes doc~ (| ¢ Quotes | ][ 1:213 At 4:40pm a couple (a boy and .. (22 1w | || Codes | E])[Purchase {4313 v ]
L 770, @ v INLC DU L CSSOO A U1 UIGLE LLSHL IUSC PANLS, ISR [SIIL 40 4 DIaCh CUmard SInt
; B L ¥ -~
over the t-shirt) walke
came up to the
know whels WRileR: |;HE”'>_<I
was worky Families: Query: (s )F J(Recalc ) Undo J( Reda ] > Acti
GoVETH [ acouives Typoioges (... A | [ENCLOSES("Adaptive Space”, Smoke) " clive
H}Era i iV @Interacﬁnn Typologie... _ 1‘!:;2;3\ SpeceT
. E ice
P 8% People Typologies (15) Dormant
Talec $2 Place Tunalnmies (211 hA
TEETEgErsy” -
3 Codes!
= with voun ("Adaptive § " ENCLOSES "Smoke”) »
7 - T (0] = ("Adaptive Space’ moke") » Query
o v floor, read + $2rsfil (20}
Within (and somd QRahglon {1-0}
\, :aaain:r i i | $FRestzurant {1-03
kL = %8 Restroom {2-0}
E | e ar S 3 2 [ Create Super Code
ncloses €—zj carby thd' B | & serior (0-0} =
B Totee E % shopping center {11-03 d Name Size | Start| De,.#
-l B mm[' L S8 sit cars [13-13 1161  Coincidentally, T was sitting .. 1 47 1 B
’—;Eﬁé‘;- 1 £ skateboard {20} 1:64 The large group of teens left .. 4 52 1 i .
OverlappM t_ahlE L $8 smake {253 Ll |Edue7  The boy with the cell phone ea.. 2 7B 1 List of quotations
by M L E €% sophomare [0-0 1:... Two teenagers (2 boy and a gr.. 21 93 1 W
3 = bt
- fﬂ/d LB gsﬂethum a0 v & | ¥
Over|aps % B ls'c“.] :p, snce in lines: 1)E Refresh Codes Sgope Help
29 0
Result: 14 TE: All
-
Follows 208 T T T T S TR T T T R b e = P Set scope of
oading dock, T neticed that there was a large number of children on the creek banks behind the $% #Coed Group
g g query
/ shopping center. There were also two middle-age mothers with small children siming on the grass by §3 =Female
Precedes the end of the bnidge (that connects the shopping center to Woodbridge High School). I drove past o4 :”0 oo
them, parked my car by Del Taco. At a quick glance Del Tace was not very busy, so I decided to walk ¥4 :‘"‘h'he iy
back toward the creek. I sat on the grass about 30 feet away from the group of voung kids. They 4 =faunge" chidren
Co-occurrénce b : Chmyaa bl : Adaptive §
appeared 1o be in middle-school age. There were about 20 kids, and the bov/gitl ratie was about 50/30. g&;ph;a HeRt
They were running around on the grass on the hillv banks of the creek (there’s almost no water). When ﬁ}"a‘aih?ng fan.
T tock closer lock, I noticed that it was mostly boys that were ninning around, and girls were standing
f i - .- 7ol N P a]

Size: 100 % Q AMST cP: 0
P S L
74 start T Atlas Workshop Note...  /* Commercial Places Co...

P 1: commercial place fieldnotes.doc -> <HUPATH>\commercial place fieldnotes.doc

&) WL = 1201PM

- Useful query tool symbols
a. Boolean Operators

- OR—"“A or B” will find all quotations linked to either code A or code B.

- AND - “A and B” will find all quotations linked to both of codes A and B.

- NOT - “A not B” will find all quotations linked to code A but not code B.

Note: When dealing with Boolean Operators, order of codes does not matter. But

the tricky part is that you have to work backward to build query, and the query

operator is always using the top two codes for constructing query.

e.g., Double click on code A, then double click on code B (it will show code B on

top of code A) - Click on “Follows” Query button - Query will be created for “A

follows B”

b. Proximity Operators

- WITHIN — “A within B” will find all quotations linked to code A, and are
contained within a quotation linked to code B.

- ENCLOSES - “A encloses B” will find all quotations linked to code A that
(partially or fully) contain quotations linked to code B.

-  FOLLOWS/FOLLOWED BY - “A followed by B” will find all quotations linked
to code A that is followed by quotations linked to code B (You can set the
distances between the two quotations).

- CO-OCCURRENCE - “A co-occurring with B” will find all quotations linked to
code A that co-occur with B.

10
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: |

Quotation 1 )
A Sample Queries:

I :
|

I .
| C B overlaps A > {Q3, Q4} !
Quotation 4 A overlapped by B > {Q1, Q2} '

I B C overlaps B > {Q5} !
! A within C > {Q2} |
| ) A overlaps C > {Q3} |
i Quotation 5 C follows A > {Q5} !
i C B overlaps C - {Q3, Q4} !
|

' |
' |
' |
' |
' |

Quotation 2
A (p. 166 from A5 User’s Guide to
Quotation 3 ATLAS.1i 5.0)

a. Semantic Operators
1, 1, < - Query for networking relationships visually

Constructing conceptual networks

- Selecting a code inside network windows
- Double click the code icon
- Draw a square around it
- Unselect a code
- Ctrl + Click
- Click inside the square area
- Remove a code from the network
- Right click > Remove from view
Note: Do not delete the code — it will delete it from HU!
- You can draw codes into the network from Code Manager
- You can add/change/remove the relationship among the codes
- Networks can be saved for future reference. Any time you change codes or
quotations, it will be reflected in the network.
- Exporting the network
- Network window - Network > Copy to Clipboard - Copy all nodes > Open MS
Word, then Edit > Paste Special > Enhanced Metafile

An example of the exported network

$% Smoke {25-3} % Sitcars {13-1}

is associated with is associated with

|ﬁ Marginal Space [58-2}~I

11
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- Customizing network relations
- Network window - Links - Edit Relations - Code-to-code Relation - Edit >
New Relations
- Internal ID means ID of the relationship
- In addition, there are three other ways of labeling the relationship.
- You can see the network by clicking on “Network button”

merciz iCe ng 2007 - ATLAS.ti

BEE
.y H X &=

(= ]

E Ol -t =
P-Docs [E])[P 1: commerciz ael| § Quol we MName
Sone. By then 1 figared that the s mere working mrrmch Sefmamork. She staye [| Betiso
walked outside to be picked up bv a white SUV that drove up to the curve_ The Middle-Eastern [ndan W‘@’éW@Fkﬁf@UﬁO n

Fights {0-0}
3 Freshman {0-0}
$3Getaride {70
£3 Gift or Entertainment store (3-0}
% Hang out {3-0}
# M || €2 1egal or Deviant £1-0}
£¥ Intended use {0-0}
£ Intended user [0-0}
¥ Jurior 00}
8 Lack of 00}
$BMarginal Space (5223~
Middle Eastern {1-0}
£3 Negative [0-0}

girl also left shortly after
023 The girls were g
1o see who came in, or |
two small bovs came it
and after geming a cook i
Indian girl were studving
was sitting earlier. He w:
least 5 minutes). The girl]
staring at them, but he di
tapped him on the should
walked out of the coffee
024 At around 5:20,

him on the table, and tool

%" Marginal Space
Network Modes Links Layout Display Specals Help

vVASENOXTEE 2t ok

«mSEM L0 T

[€3 Sit cars {8-1} (€3 Smoke {10-2} [

99 French bakery Champagf $2 Cther fast food {10-0}

= running pants with white E $perk 00

S bov at around 530 This Qpag midnight {0-0}

= to black boy ang 47 s s accotisted wi < 2ssociated with Ko 00}
s0 it was prnbx a smof = > gﬂoeuagar}r

T [prepared, there wasaa it Purchass

The Latine bov left along] QREE ‘nﬁ j['elat'ons
the black boy put on a bl: $4ReglBton

B the table. When I looked QREM‘U comments
began walking toward th $& senior {5-07

025 At around 6.00p g %@@fve ithe network

toward Tully’s with a limlff ¢

alone by then), they appe}

gitl decided to walk in zigl o

ta the black girl working on the homework. The black teen turned around and said “Hi __ (the girl's
name}!” The lirde girl quickly mrned and went back to walk with the man. When she left the Indian girl

3 sit cars (8-1
Qsmebu.armng (5-0}
3 smoke {10-2}

£3 5ol 20}

£ sophomore {0-0}

2 spectrum {3-0)

said “vour sister’s so cute!” |
< | >

026 About 10 miutes later, the black girl looked up and saw that the man ges tured her to go by
waving hand away from the coffee shop. The girl said “Oh. are we leaving right now?” But the man

did not wait for her and began walking toward the parking lct (He was not with the little girl at this

time). The Indian girl asked her “Are vou leaving risht now?” And the black girl responded “T'm calling ¥

Recovery backup: 12:24:29 PM
e
74 start | @ Atias workshop Mote...

Network Links

Two ways of thinking about links
- Grounded (How many quotations are linked to a code)
- Density (How many codes are linked to a quotation)
Two kinds of links
- Regular/automatic/low-power links: Code-code relationships
- High-power links: Quotation-quotation relationships (e.g., hyperlink)
- They are both the same mechanisms. They are just titled differently.
Linking codes in network
- ltis simply a cognitive exercise. There are no consequences to the rest of the
HU.

bt aead

Space with least defined usasfusers. Staka for
the property owner is lowest.

7Codes | Marginal Space {5: Al Mame - Tite

# Commerdal Places Co... 12:31PM

= 2
rim:

Grounded: Number
of quotations linked
to a code

Density: Number of
codes linked to a
quotation
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Creating table of coding frequencies

- Tables created can be exported to Excel (then to SPSS)

- Steps to create the table [Optional steps]
[Code manager - Filter code family] and/or [Primary Doc Manager > Filter
document family] > Code Manager - Output - Codes-Primary-Documents-Table
- Quotation Count (Excel) 2 File & Run - Ok

= - [=]%]
E. Code Manager [H... [Z |[E|[]
Codes Efj\t Miscellaneous el

. Z = view |
p-Docs [E])[P 1: commercial place fieldnotes.doc~ v | ¢ Quotes | [E)[ 1:475 The store was getting crowded, .. (48 v | | Codes [F] - |

- — % |
" [408 ]| = e Subte
£ 407
D |408 * §|MQUEWTDD‘
— |400 Code List

Code Hierarchy

Codes Neighbours

Media
Rich Text <...

Id = Name

#ip 1

commercial place ficidnates.doc
501

502
L]

Quota...
458

Author
Super

Created Mot

FETET T rIMEY|  Quotation Count (Excel)

Quotation Count Report [T ————

Quatation References
All Codes with Quatations
Print Codes with Comments

Word Count Report
Word Caunt (Excel)

g TIEE t
3 coffecshep TITOT

£ Del Taco {310}

$32 Electroric or Computer stare {2-0}
£2 Gift or Entertainment store {3-0}
$¥IMarginal Space {58-2p~

$2 Other fast food {10-0}

£2 park {10}

$erme Space {105-23~

{10}

%

Allthe fidlenotes cambined

$2 shopping center {110}
$2 Spectrum (30}

$2 soectrum street {3-0}
$2 Street {10}

$2 supermarket {10}
$2 Tea house {303

|

1Primary Doc

P 1: commerdial place fieldnotes.docq FiMain fieldnote Id - The P index

&

expression, as she had her eves open and wasn’t smiling. Then the mether went back to talking with |
her daughter, and the friend got up from the table and excused herself, carrving her purse. The mom =~ ¥

Output Code PDMatrix As CSY

Recovery backup: 12:05:33 AM
/4 start

7 Commerdal Places Co...

B3 Microsoft Excel - Commercial Places Coding 2007_CPD_Matrix

iE] fie Edit Vew [nsert Fomat Took Dats  Window Help

HRR=R" RSN TE -SR-S T ) !E»\Ha\

W0 | (3 By (-3 ] Y9 Renly with Changes..._End Revieu... !

EN st B 7 R R ||

| @Y Atlas Workshop Note....

e i L

B Micosoft Excel - Com...

Type a question for help

s A B

Al h # CODES-PRIMARY-DOCUMENTS-TABLE

B [ ¢ [ o [ E T F ]

G ]

H

A
CODES-PRIMARY-DOCUMENTS-TABLE
Report created by Super - 01/05/07 12:07:10 AM

Code-Filter Code Family "Place Typologies” [21]
PD-Filter Primary Doc Family “Main fieldnotes” [1]
Quotation-Filter: All [458]

&Duplicat Adaptive SBathroom Bookstore bubble
P 1- comm 1 107 1 7 1
TOTALS 1 107 1 7 1

mRRl=l=l==]=l=]=]=]<]= -

8
8

Clothing st Coffee sho Del Taco

13
13

HU: [C:\Documents and SettingstYuki Kato\My Documents\Projects\Disse...\Commercial Places Coding 2007.hpré]

Electronic Gift or Ent{Marginal S Other fast Park Prime SpaRe
3 2 3 57 10 1 105
3 2 3 57 10 1 105
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rinting output of quotations

- Produce a list of all quotations linked to a code in Word.

- All of the quotations linked to a code:
Code Manager - Highlight the code you want the quotations for > Output >
Quotations for selected codes - File & Run > OK

G-2» ey

[P 1: commercial place fieldnotes.coc~ ~| | Quotes ][ 1:475 The store was getting crowded,.. (49 v | | Codes B[

View

= f Quotstion List for Selected Codels)
| Indude Subterms

oMl | E Primary Doc Manager Commercial Places Coding 2007] X & EI #h Query Tool

= 12| pEesEn 2 : | Codelist
m g A X -y Name & Code Hierarchy

500 $3sDuplic  Codes Neighbours

Id « | Name Media Quota... | Author Created Modified L $Padapty  Codes-Primary-Documents-Table  #
WP 1 commercial place fiekinates.doc~ RichText <... 458 Super 13/12/06 02:...  03/05f0712... v NI §%Bathred  Quotation References
501 $25ookste Al Codes with Quatations
$2bubble]  Print Codes with Comments
€2 Clothini Print Conceurring Codes
2 Coffes FERTIIOY
% Del Taco {310}
Electronic or Computer store {20}
Gift or Entertainment store {3-0}

{58-2}~

$2 Other fast food {10-0)
_ |502 $2park {10}
< m > $hprime Space {105-3~
— — {103
All the fidlenotes combined 22 Shopping center {11-0}
503 2 spectrum (30}
= 3 Spectrum street {303
T | 504 €3 street {10}
$2 supermarket {1-0
% Tea house {30}

S
|| I Space with least defined
v

=

1 Primary Doc ? 1: commercial place fiednotes. doc+ Filvain fieldnate 1d - The P index

expression. as she had her eves open and wasn’t smiling. Then the mother went back to talking with
her dauchter, and the friend got up from the table and excused herself. carrving her purse. The mom

[

uses/users. Stake for the

JPrints all quotations for selected code

! fle Edit Vew Insert Format Tools Table Window Help Type a question for help [/ %
NEElE o o . e
2w e % 2
—
EE\:\\\»\ . a
|57 quotation(s) for code: =
Marginal Space

Report mode: quotation content, memos and hyperlinks
Quotation-Filter: All

| 110% - E A4 Mormal +Tahor = Tahoma

HU: Commercial Places Coding 2007

File: [C:\Dacuments and Settings\Yuki Kata\My Docurnents\Projects\Disse.. \Commercial Places Coding 2007.hprs]
Edited by:Super

Date/Time: 01/05/07 12:12:20 AM

P 1: commercial place fieldnotes.doc - 1:3 [I saw two people sitting insid..] (7:7) (Super)
Codes:  [#Male] [#Withs] [Marginal Space] [Sit cars]
No memos

1 saw two peaple sitting inside silver Civic in the parking lot. They never came out of the
car while I was observing,

P 1: commercial place fieldnotes.doc - 1:4 [At 5:15pm, two pickup trucks d..] (8:8) (Super)
Codes:  [#Male] [#White] [Marginal Space] [Smoke]
No memos

At 5:15pm, two pickup trucks drove in to the parking lot. One parked at the comer of the

parking lot, closer to Del Taca. Inoticed that the driver locked inta the patio as he drove by
it before parking the car. The other pickup truck parked at the lot closer to Del Taco, but not
at the back row. It parked next to a red car that was already parked there. Thee boys came

out of the second truck, and two of them stood by the truck to smoke cigarette. %
<@
P 1: commarcial nlace fialdnotes.doc - 1:6 Tand T saw three mora whita tee.1 (8:R) (Sunar) &
Ele = =a< ] )
iDraw~ L | Autoshapest N\ W [ O [ i8] 4] £ (8] @\&'A'Efg a ﬂ!
Page 1 Sec 1 Y15 | (At 1" lni cdi Engish (U5 (D

B3 Microsoft Excel - ...
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Coding Videos (and audio files, too)

- Creating quotation

- Play the video (or audio file) by selecting the clip at the primary document (Video
will play in another window, so click on it to show above the Atlas window) -
Click “Mark Selection Start” at the beginning of the clip = Click “Mark Selection
End” at the end of the clip

- The quotation is created and you can see it in Quotation Manager

- You can drag codes from Code Manager to code the quotation just like you
would if it were text.

Play video by selecting it in PD

B SHEM

m g |

¥

Recovery backup: 10:24:53 AM

window

b \\/iNdOW

Mark Selection

Eﬂ £ serior

f:2 mmcoding. avi (182 215) F I
[ |
4 528 K4 M LI

F: 215 33 frames

B »B X -

7 start | T AtiasWorkshopNote... | * Commercial Places Co...

Den... | Name Start | Size | Author
Caitin said “There .., 395 1

Shela emphasized ... 3% 1

I asked them "Oka... 397 1
Twogrlswakedu... 398 1 Super
Elvis pointed to th... 1 Super
Tanizkeptaskng.. 373 1 Super
Lasked Whatabo... 379 Super
M Super
Super
Super
Super

Super
Super
Super

| mmcoding.avi
.

el T et etatiie

€% Restaurant {1-0} St art
{0-0}
Shopping center {100}

Mark Selection
End

€3 University High {1-0}
aiting for action {5-0}
alk {20-0}
ater cup from Del Taco {30
e average kids in Irvine {1-0}
oodbridge High {2-03
ork {1-0}
Warld beyond bubble {3-0}
Experiment with video {1-0} ]
>

Linked to one

Video plays in a new

code

7 p 8: mmcoding avi

Click to show above Atlas

30 O Experiment with Al Name - Tit

Q'/." WL = 0:29AM
¥

Coding graphic images

- Creating quotation

Right click text area > Selection - Display type = Inverted area
Draw a square while holding down left click to create quotation (The selected area
gets inverted like a negative) - Drag a code from code manager

- One way to effectively use the image is to hyperlink the text and graphic (to explain

the text quotation using graphic presentation)

- You can also network the graphic images with hyperlink

- Two ways of expanding and contracting the graphic

b. Ctrl+Wheel
c. “Expand/contract images” button (Hold down Ctrl to contract)
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File Edit Documents Quotations Codes Memos Metworks Views Tools Extras Windows

E-EE - = @ - > ey
P-Docs P2 CIMGI162.0PG ~ Quotes 2:1 CIMG3162.IPG (253:973) Codes langry {1-0} ~ Memos §| b

Help

£ adaptive Space~

] ﬁ Marginal Space ~

Navigating ar
Object Crawler
- It allows you to search for a word (or any string of text) in one or all or any Object Crawler:
combination of objects. search for a word in
Click on Object Crawler button = Define query (the word you're searching for) > any part of the HU
Check everything in Search Scope, but uncheck GREP - Select Objects by
checking specific objects
Note: It's case sensitive, so place “*” as the first character in search

» Obiect Crawler

E!, Code Manager [H...

K-OH EM S e ey
F] [P 1: commercil place fieldnotes.doc~ (3] | Guotes | [F][ 112 When I got to Del Taca, there .. (7i7) W] i Codes [F])[Drive (130} i Memos | ][ |
People. dhcud sad VI, NEVe YOU SEeil mal DIack guy mal Kind Of WODDIES ! 10SV all 1augnea, out ] | y e
_| tive Space~

knew exactly who she was talking about. This was the man that the Asian security guard was calling
attention of earlier with his whistle. Tania told us that one time he told her that he’d talk to her parents
because they spa d “Yeah!™

NPUMMMEINY  ATLAS. 1 Object Crawler X il
f == 3
on at the same tif fhe patio,
and the black seql  DeME @Y MM' 1d us he
said “Yup..."Aq query:  [bubble v |daway
Jake told us that ard tried to
take his scooter fila said that
g [use Grer .
one security guar| 4
swarning. Accord] | SearchScope v the » Uncheck GREP
parking lot. and { lai jous” and
we all laughed atf  [ZIName
Sheilaeny  [#] author er. She
contended that tf Date we had to
— buy food herel” §  Bcamment ens said
E “Sh }'ihah,,,r but] [P content sr.m_to
chase them away “It's not
so much the type H “Here, or —
= Alion square. "
FE (207 T asked {] where
people hang out’) id “But they
took the heat an
November...” El to go to
Domut Star in Al il the

morning. and brought coffee for some friends the next morning. That. and “University Del™ were the
only place open 24 hours, at least when she was in high school She said that when she went to
University Del, people were mean to her. T asked her why, and she said “T don’t know. I've never
been to Uni, so I don't know what it's like and why they're man to us. But some people from Uni
also came to this Del and tried to start fights ™

398 Two gitls walked up to the patio, and began talking to Sheila I had been there for about an

Bl it Pt i aivin Sk cmienian fhiinen T ek i il ool ot s el bl i i T b

: C:\Documents and Settings!Vuki Kato'My Documents Projects!Disser tation\Commerdial Flaces CodingCommerdial Places Cod

# Commerdal
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Object Explorer
- List of objects
- Graphic (Network) view of objects
- Outline lists

Sorting Codes
- Code Manager-> Codes - Sort:

Name

P 1 ol place Seideates o

Wasdbridie Village: Del

-&
=3 February
= 5:00-6:00pm (1,0
= Diel Taco Bammnc) — gy g 2 way 5%
o= Wisen | gefl | w0 JT Commercial Maces Coding 2007 P
s window, fiscing thy =
=, bicycles Children| - t
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“ see what they werl
boys came out tw inside
v silver Civic i the
Ar 515 * e
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second tuck, and| .-. the
T restmarant to arde @ od
] They saz at the paj . oth,
and 1 saw twee o F
£ restanrant and the T NetworcViews (0) -
< »
4:50-6:30pm (1:40
ove to by
Tully's coffee shog 1
walked past the oo fihe
voungest ones wey bshers
standing neasby. O Commeroiel Places Codng 2007 ack
There's a Kumen rom the couryard, and these Tady wah backpac]
accemparied by ene adu'h were 90%% Asans). | then wallked to Bames and 3

Towad & provp of thres teens (mom Iooked Asiam) sniag and reading Mangs comic books
isles, l:m othey 1llm I!ul 1 did ne f\xu! Ay Irﬂ-ugn adide.

s

&

P

Name =

$3 esecurit
9eSecurit
eTeen/T
ﬁ | 8Duplical

oacaptve

Info

Duplicate
Split Cade

Code Tree

Link Manager
Relation Manager

Import Code List

fePERE|  CodeForest |

Kato & Rudes Atlas Workshop I

Object Explorer:

List of objects in HU

-
Code Forest: List
of all codes (shows

L links among codes)
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Trouble-shooting

Creating details of HU for getting help from Atlas.ti support
- Extras > System Report

Team Project

Each person on the team has a version of HU (different names) to be merged
periodically
- An example of naming individual HU: projecttitle.membername.date
Use fool-proof option in merging HU files
Merging HU check list
- All HUs has all PDs
- All PDs are in the same order
- Unify everything
Tip: “Add” option (instead of “unify” or “ignore”) is best in checking for coding liability
across multiple coders.
Ways to avoid confusion when working on a team project
- Only one person assigns PDs (to all copies of HUs)
- Each merge is a good occasion to clean-up any confusions and
inconsistencies
- Constrain what you do, when it comes to adding or deleting codes.
- When creating a new code, add initial and comment with date and initial
- Use comments heavily and initial and date each comment.

Data Source Management Menu

Change path
Documents - Data Source Management - Change path - Select the new location

of the document

(If you're using the foolproof method you won'’t need to do this)

Edit primary document mapping

Documents - Data Source Management > Edit primary document mapping - You
can set alternative location for the HU to look for the document if it’s not in the
original location

Reset last access information

If the file sizes change Atlas will give you a warning. You can simply tell Atlas to
ignore it (it sometimes happen with Word, even when you don’t edit the file).
Accessibility report

If the document size changes Atlas will give you a warning. You can reset it and
continue using the HU.
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About the workshop facilitators

Yuki Kato and Danielle Rudes are both qualitative researchers who have used Atlas.ti for roughly two years. Together,
Yuki and Danielle attended a two-day workshop with Woolf Consulting near Santa Barbra in December, 2006 to formally
study Atlas.ti and all that the software has to offer. Since then, Danielle and Yuki have coded thousands of pages of data
from their respective dissertation projects and have conducted several introductory and intermediate Atlas.ti workshops at
the University of California, Irvine, George Mason University and the American Sociological Society’s Annual Meeting in
Boston, MA (didactic workshop) for interdisciplinary audiences. We welcome your attendance, participation and
comments.

Yuki Kato Danielle S. Rudes

Tulane University George Mason University

Sociology Department Administration of Justice Department
ykato@tulane.edu drudes@gmu.edu

Note about copyright and licensing
Yuki and Danielle contacted Atlas.ti’s customer service division (in Germany) about copyrighted materials and to get their approval for our workshop.
We received positive and encouraging responses from them regarding the workshop and our handouts.
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